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1.1.

1.2.

1.3.

Introduction

This manual

This manual provides thorough information on the SPA-ZC 400 Ethernet Adapter
and the central concepts related to it. SPA-ZC 400 Ethernet Adapter is used for
connecting REF 541/3/5, REM 543/5 and RET 541/3/5 Intelligent Electronic
Devices (IED) to the Modbus/TCP Bridge. In the manual you find information on
SPA-ZC 400 and its components, an introduction to engineering tasks and a
description of the basic operations.

The information in this manual is intended for application engineers, who install and
configure SPA-ZC 400.

Use of symbols

This publication includes the following icons that point out safety-related conditions
or other important information:

The electrical warning icon indicates the presence of a hazard which
could result in electrical shock.

>

ih"““ The caution icon indicates important information or warning related to
- the concept discussed in the text. It might indicate the presence of a
hazard which could result in corruption of software or damage to
equipment or property.

E The information icon alerts the reader to relevant facts and conditions.

It should be understood that operation of damaged equipment could, under certain
operational conditions, result in degraded process performance leading to
information or property loss. Therefore, comply fully with all notices.

Intended audience

This manual is intended for installation personnel, administrators and skilled
operators to support installation of the software.
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1.4. Product documentation
Name of the manual Document ID
SPA-ZC 400 configuration CD 1MRS151048
CAP 505 User's Guide 1MRS752292-MUM
SPA-ZF Optical glass fibres, multimode granded [1MRS755371
index type
Plastic-core fibre-optic cables, Features and 1MRS752089
instructions for mounting

1.5. Document conventions

The following conventions are used for the presentation of material:
e The words in names of screen elements (for example, the title in the title bar of a
dialog, the label for a field of a dialog box) are initially capitalized.

e Capital letters are used for the name of a keyboard key if it is labeled on the
keyboard. For example, press the CTRL key. Although the Enter and Shift keys
are not labeled they are written in capital letters, e.g. press ENTER.

e Lowercase letters are used for the name of a keyboard key that is not labeled on
the keyboard. For example, the space bar, comma key and so on.

e Press CTRL+C indicates that you must hold down the CTRL key while pressing
the C key (to copy a selected object in this case).

e Press ALT E C indicates that you press and release each key in sequence (to copy
a selected object in this case).

e The names of push and toggle buttons are boldfaced. For example, click OK.
e The names of menus and menu items are boldfaced. For example, the File menu.

e The following convention is used for menu operations: Menu Name > Menu
Item > Cascaded Menu Item. For example: select File > Open > New Project.

e The Start menu name always refers to the Start menu on the Windows Task Bar.

e System prompts/messages and user responses/input are shown in the Courier
font. For example, if you enter a value out of range, the following message is
displayed: Entered value is not valid.

You may be told to enter the string MIF349 in a field. The string is shown as
follows in the procedure: MIF349

e Variables are shown using lowercase letters: sequence name
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1.6.

Revision history

Version Date History

A 30.06.2006 Document created

B 20.05.2009 SPA-ZC 400 2.1.2 additions
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2. Safety information

Non-observance can result in death, personal injury or substantial
property damage.

Only a competent electrician is allowed to carry out the electrical
installation.

National and local electrical safety regulations must always be

followed.
i\ The device contains components which are sensitive to electrostatic
l\ s/ discharge. Unnecessary touching of electronic components must

therefore be avoided.

11
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SPA-ZC 400

Product overview

SPA-ZC 400 is used to connect one REF 541/3/5, REM 543/5 or RET 541/3/5
device with the Modbus protocol over the TCP/IP network using the same Ethernet
link. SPA-ZC 400 converts Modbus RTU messages to Modbus TCP. The IED is
configured like Modbus RTU device. SPA-ZC400 provides simultaneous dual port
communication for fibre-optic SPA and LON.

| Substation
| Monitoring To control
And Controlling centers

System
=7 Modbus/ - — COM600
Ethernet )
adapters : Industrial ¥ (SBl;lt)es\t\?glon
SPA-ZC e GPS fibre-optic y
400 and 402 Ethernet switch TCP/IP
\ /\ \ e ‘ network
I
e — — == 5
n — A=
SOLS EE == E=] .'.
-~ ?- 3rd party devices
REF 543 REF 610 REX 521

A060009

Fig. 3.-1 Conceptual picture of a typical system setup

The mechanical and electrical connection of the Ethernet adapter to a REF 541/3/5,
REM 543/5 or RET 541/3/5 interface is described in Section 4. Installation. The
Ethernet adapter programming is described in Section 5. Engineering.

It is a prerequisite to understand the communication properties of Intelligent
Electronic Devices (IED) before connecting to the Ethernet adapter. This
information is available in the manual for the protection relay in question. It is also
necessary to have basic understanding of the Modbus/TCP Bridge to which the
IEDs will be connected.

ABB has tested the following third-party devices, which are recommended to be
used with SPA-ZC 400:

Industrial 10/100 MBit switches:

e RuggedCom RS800
e RuggedCom RS1600
e Westermo FST208

Media converters:

¢ RuggedCom RMC-100-MM
e IMC McBasic MM1300
e Allied Telesyn AT-MC302-20

13
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3.1.

3.2.
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More tested devices can be found on the ABB web site
http://www.abb.com/substationautomation.

SPA-ZC 400 and optional LON/SPA interface

The optional interface provides a connection between the REF 541/3/5, REM 543/5
or RET 541/3/5 device and the fibre-optic SPA and LON. The bus connection
module converts incoming optical signals from the SPA and LON bus to electrical
RS-485 signals for the REF 541/3/5, REM 543/5 and RET 541/3/5 devices and vice
versa. It contains a service pin for LON nodes.

The optional interface can be used in loop- and star-type bus topologies. It is
possible to select the idle state of module line. The light can be turn on or off. The
jumpers select the bus topology (loop or star) depending on whether the light is
turned on or off.

In the loop topology, the interface receives the message from the fibre-optic
interface and passes it both to the fibre-optic transmitter and to the RS-485 interface.
In the star topology, the interface receives the message from the fibre-optic receiver
and passes it only to the RS-485 interface. If the message is received from the RS-
485 interface, it is passed to the fibre-optic transmitter in both bus topologies.

The SPA bus communication uses loop and light off modes, when the module
jumpers are in loop- and light off- positions. The LON bus communication uses star
and light off modes, when the module jumpers are in star- and light off-positions.

In the LON bus communication the optional interface supports collision detection.

The service pin is connected via the RS-485 interface to the device's Neuron chip,
which is connected to the interface.

Table 3.1.-1 Settings of the jumper

Topology Light on/off Protocol
Star Light off LON/SPA
Star Light on Not supported
Loop Light off LON/SPA
Loop Light on Not supported

Features

SPA-ZC 400 has the following features:

e Simultaneous dual port communication (plastic and fiber optic connections) for
Modbus and LON/SPA

e Support of Modbus communication over TCP/IP
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3.3.

ABB Y
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Fig. 3.2.-1 Parts of SPA-ZC 400

Ethernet connector

LON/ SPA bus connector (optional)
LON/ SPA Rx LED

LON service pin

LAN and diagnostics LEDs

DN W=

Transmission Control Protocol (TCP)

The Transmission Control Protocol (TCP) is the most commonly used protocol for
exchanging data between communication devices using Ethernet. Unlike UDP, the
TCP protocol guarantees reliable transmission between applications. TCP also
distinguishes data for multiple, concurrent applications running on the same host.

A data message sent as a TCP/IP message means that the higher layer Transmission
Control Protocol assembles the message or file into smaller packets. These are then
transmitted over the Internet and received by a TCP layer which reassembles the
packets into the original message.

15



16



1MRS756014

Ethernet Adapter SPA-ZC 400
Modbus/TCP Brigde

Installation and Commissioning Manual

41.

4.2.

4.21.

422,

Installation

This chapter describes the installation of the SPA-ZC 400 module and the
Communication Engineering Tool (CET) for SPA-ZC 40x. For additional
information, such as technical data, maintenance and service, refer to Section 7.
Technical data and Section 8. Maintenance and service.

Mechanical installation

Connect the SPA-ZC 400 module to REF 541/3/5, REM 543/5 or RET 541/3/5 and
screw SPA-ZC 400 to the 9-pin type D-connectors. Connect the LAN cable to the
LAN connector of SPA-ZC 400. The other end of the cable is connected to the
Modbus protocol over TCP/IP through the Ethernet switch.

Communication Engineering Tool for SPA-ZC 40x

System requirements

Communication Engineering Tool (CET) for SPA-ZC 40x runs on Windows 2000,
Windows XP and Windows Server 2003 operating systems. A PC capable of
running one of these operating systems is sufficient also for CET for SPA-ZC 40x.
For more information, refer to Section 1.4. Product documentation. The detailed
system requirements can be seen below.

e 20 MB free hard disk space if Microsoft .NET Framework 1.1, which is required
for running CET for SPA-ZC 40x, has already been installed.

e 100 MB free hard disk space, if the Microsoft .NET Framework 1.1 is not
installed. It is installed automatically if it is not found.

Installing Communication Engineering Tool for SPA-ZC 40x

1. Uninstall the previous version.

2. Close all the open programs and insert the Communication Engineering Tool
(CET) for SPA-ZC 40x installation CD to the CD-ROM drive of your PC.

3. The Installation program starts automatically. If this is not the case, open the
program by starting setup.exe on the CD drive.

4. The installation wizard extracts the installation files to your local computer.
5. The CET for SPA-ZC 40x Installation program starts. In this dialog, click Next.

e With the Back button you can return to the previous dialog, and with the
Cancel button, exit the installation wizard. This applies to all the dialogs in
the installation wizard.

6. Read the License Agreement, select the option I accept the license agreement
and click Next to continue the installation.

e If the option I do not accept the license agreement is selected, the Next
button is not available and you cannot continue the installation.

7. Select the folder in which the application is to be installed.

17
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4.3.
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e To select the default folder shown at the bottom of the dialog, click Next.
e To select another folder, click Browse, choose the folder you want and click
Next.
8. Both manuals are installed by default on your local hard drive. Click Next to
continue the installation.

e To install a manual, click the respective manual and select Will be installed
on local hard drive.

e To install the documentation feature, click the respective manual and select
Entire feature will be installed on local hard drive.
e To install the manual when required, click the respective manual and select
Feature will be installed when required.
e Not to install the manual, click the respective manual and select Entire
feature will be unavailable.
9. Click Next to begin the installation.
10.Follow the progress of the installation in a dialog that also shows the directory

path where the files are copied. At this point, you can still cancel the installation
by clicking Cancel.

11.A dialog opens to show that the tool has been successfully installed. Close the
dialog and finish the installation by clicking Finish.

12.When clicking Finish, the wizard also installs the Microsoft SQL Server
automatically, if it is not installed already.

13.Start CET for SPA-ZC 40x by selecting Start > Programs > Communication
Engineering Tool for SPA-ZC 40x > Communication Engineering Tool.

Uninstalling Communication Engineering Tool for SPA-ZC 40x

1. Open the Add or Remove Programs dialog by selecting Start > Settings >
Control Panel > Add or Remove Programs.

2. Select Communication Engineering Tool (CET) for SPA-ZC 40x and click
Remove.

Uninstall CET for SPA-ZC 40x in order to install a new version and to
update the software. Uninstallation does not remove the Microsoft
SQL Server and .NET Framework. Removing these programs can
affect the functionality of the other ABB applications.

Detailed instructions for upgrading the software are provided when the
upgrade is available.

Connecting to SPA-ZC 400

The Sections 4.3.1. and 4.3.2. describe how to connect to SPA-ZC 400 from the
Communication Engineering Tool (CET) for SPA-ZC 40x.
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4.3.1.

43.2.

Changing computer's IP address

To connect SPA-ZC 400, the used computer and SPA-ZC 400 must use the same
address space.

To change the computer's IP address space to be the same as in SPA-ZC 400:

1. Open the Network Connections in Control Panel.

2. Type, for example, the following IP address to the IP address box: 192.168.2.1.
See Fig. 4.3.1.-1.

You must have system administration rights to perform the task.

Internet Protocol (TCP/IP) Properties 7| x|

General

Y'ou can get [P zettings azsigned automatically if vour network, support:
thiz capability. Othenwise, you need to ask your network, adminiztratar for
the appropriate |P settings.

™ Obtain an IP address automatically

—{* ze the following IP address;

IF address: 192168, 2 . 1
Subnet mazk: I 285 266 285, 0
Default gateway: I

= Obtain DHE semen address automatically

—i% Uze the following DMS server addresses:

Preferred DS server: I

Alternate DS server: I

Advanced... |
k. I Cancel |

A060241

Fig. 4.3.1.-1 Changing IP address

Checking connection to SPA-ZC 400

Check the connection to SPA-ZC 400 by using the ping command:

1. Open the Run dialog.
2. Type cmd to the Open box, see Fig. 4.3.2.-1.
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Run 2| x|

Type the name of a program, folder, document, ar
Inkernek resource, and Windows will open it For wou,

Open: =]

(0] 4 I Cancel | Browse, .. |

A060242

Fig. 4.3.2.-1 Starting command prompt

3. Click OK to run the command prompt.
4. Type ping 192.168.2.10, see Fig. 4.3.2.-2.

C:\Dping 192.168.2.18

Pinging 192.168.2.18 with 32 bytes of data:

Reply from 192.168.2.18: bytes=32 timed{ims TTL=255%
: hytes=32 time{ims TTL=255

: bytes=32 time{ims TTL=255
: bhytes time<ims TTL=255

Pingpstatistics for 192.168.

ackets: Sent = 4, Recei - Lost = @ {8z loss>.
in milli—seconds:
Mininum = Bms, Maximum = Bms. Average = Bms
IC D,

Fig. 4.3.2.-2  Pinging SPA-ZC 400

SPA-ZC 400responds to the ping command if the computer and SPA-ZC 400 are
on the same network.

5. If SPA-ZC 400 responds with the IP address, the connection is established
between the computer and SPA-ZC 400.
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5.1.

5.2.

Engineering

This section guides when performing the engineering tasks required before using
SPA-ZC 400.

Note that all the possible engineering scenarios are not included in this
manual. You must have engineering rights to be able to perform the
tasks described in this section.

Overview of engineering

The engineering and maintenance of SPA-ZC 400 is done by using CET for
SPA-ZC 40x functions. The device's communication structure is described in the
Project Explorer dialog. The structure is built by using device objects. These objects
have communication properties that can be accessed through the Object Properties
dialog. These properties define for example the IP addresses, unit addresses, and
descriptions.

The communication structure consists of Modbus devices.
When the structure is complete and all the objects have been set up properly, the
configuration is downloaded through FTP to SPA-ZC 400 by using the CID

(Configured IED Description) Export function.

The engineering tasks are the following:

—_—

. Building an object tree by adding a device to the configuration

2. Configuring object properties, for example modifying TCP/IP address
3. Configuring Modbus communication parameters

4. Exporting configuration data to SPA-ZC 400

Creating project

You need to start the Communication Engineering Tool (CET) for SPA-ZC 40x to
open and name a project, see Fig. 5.2.-1 and Fig. 5.2.-2.

21
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EETLocal Server',REF543R IEC61850 Teskt - Commu
File | Edit  Miew  Tools  Window  Help
||ﬁ-’- OpeniManage Prajeck. .. Chrl+0 |

Close Project

EH zave Chrl+5
Reload Current Project Ckrl+35hift+F11

Exit

Fig. 52.-1 Opening a project

A040013B

zl
Currently available projects:
R Proi 1 my compLte
@ Sl ey Project ll
New Project Server name:
IVINFL‘I 0E\PCMSERVER
SO Project name:
Blete Froject IF'mtDcol Tes|
% Drescription:
Impaort Project
[
Export Project
IE [pen Project |
Create I Cancel
% Pro | Llose |
SOL Server
Service
I anager

A040014B

Fig. 52.-2 Creating a new project

5.3. Restarting

Use this function to restart the SPA-ZC 400 at runtime.

1. Select IED and Tools > Reset Tool to open the restart panel, see Fig. 5.3.-1
2. Click Reset.

The results are reported to the UI text box.

SPA-ZC 400. When download is finished, SPA-ZC 400 is restarted
automatically.

(i '\ Do not use the restart function while downloading configuration to
e/

22
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SPA-ZC 400

5.4.

N EET Local ServerExample - Communication Engineer

File  Edit  Wiew Window  Help
= | & &3 signal Mapping
& IP Query Tool

f Project Explorer

Communication | 4 CIDExport

= ifi E=ample |ﬁ| Restart SPAZC40x:
ﬁ 3D Browser

..... = -

Opkions. ..

Fig. 5.3.-1 Restarting

Building object tree

A060396

After creating the project you need to build and configure an object tree in the
Communication Engineering Tool (CET) for SPA-ZC 40x to define the

communication structure.

Fig. 5.4.-1 shows an example of the object tree when it has been built. In the
example tree you can see the SPA-ZC 400 object and its child objects as devices
and data objects. Indentation is used to indicate the parent-child relationship

between the objects.

23
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EETLocal Server'\REF54x MODBUS_TCP Test - Communication Engineering Tool for SPA-2C40% - |EI|5|
File  Edit Wiew  Tools  Window  Help
@ BER|E
Project Explarer Object Properties o=
Communication | . &l |
=8 REFS4x MODBUS_TCP Test 5 [010] Basic
=B -0 40 MODELS
b ”"" JHCDEL= Default Gateway 192.168.2.1
| v TP seer ro0i
- LN LPHDL ErVEr e
E|---L_III Lot SMTP Server 2 127.0.0.1
CLN LLHOL Subnet mask 255,255,255.0
‘LM LPHOM TCP-Keepalive 10
B Misc
Capkion SPAZC40x_MODEUS
Description MODEUS 3P4 Gh
Bl user Level
UserLevel Engineer
Caption
i
A051858
Fig. 5.4.-1 Example view of the SPA-ZC 40x Communication Engineering Tool

You have several possible ways to add objects to the object tree in the

communication structure:

¢ You can use the right mouse button (right-click) to select the object to which you

want to add a child object.
e You can copy the object.
® You can select the object using a drag-and-drop operation

Add the objects in the following order:

1. SPAZC40x_MODBUS Device object (SPA-ZC 40x)
2. Logical Device objects

3. Logical Node objects

4. Data objects

24
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5.4.1.

5.4.2.

5.5.

Adding Device object

To build the object tree:

1. Add a SPAZC40x MODBUS Device object in the communication structure by
selecting the project name.

In the example, the project Protocol Test is selected.
2. Right-click Protocol Test
3. Select New > Tunneling > SPAZC40x_MODBUS, see Fig. 5.4.1.-1.

A project can contain several tunneling device objects, for example all substation
feeders.

EET Local Server',ProtocolTest - Commmunication Engineering Tool for SPA-ZC40%

File  Edit  Wiew Tools Window  Help

Collapse

| Mew 3 | Mew...

Properties IECE1850 »

Tunneling ¥

S SPAZC40xSPATUMMELING

A051852

Fig. 5.4.1.-1  Adding a Tunneling Device object

Ensure that the new IED name is unique within the planned network by renaming
the IED, for example REF545 F1.

A Tunneling Device object cannot be configured for an IEC 61850
gateway.

Adding Logical Device objects

For tunneling devices, there is no need to add logical devices inside the parent
object. Logical devices LDO and LD1 are already included to maintain the SCL
compatibility.

Configuring by using imported CID file

If you have to configure several SPA-ZC 400 with the similar settings, it is possible

to import a previously generated CID file and change the communication addresses,
typically by changing the IP address.
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Create a new project and add a SPAZC40x_MODBUS Device. Select the CID
import function by right-clicking the LD1 logical device. In the CID import dialog
you can select the right CID file from the workstation directory and import it to a
previously created logical device.
5.6. Configuring communication parameters
SPA-ZC 400 communication parameters are located in the device properties.
SPA-ZC 400 uses static IP addresses, which have to be defined in the planned
network structure.
For uplink network settings, see Sections 5.6.1. Uplink network settings and 5.6.2.
Communication parameters for Modbus.
5.6.1. Uplink network settings

EETLocal Server',REF54x MODBUS_TCP Test - Communication Engineering Tool for SPA-ZC40x% - |EI|£|
File  Edit  Wiew

Tools  Window — Help

COhbiject Properties o
B &
Eﬂ EEF54U5 B [010] Basic
- ”""""— Default Gateway 192.168.2.1
b L E—
~ LN LPHDL Erver e
E|---L_III L1 SMNTP Server £ 127.0.0.1
C LW LLMO1 Subnet mask. 255,255,255.0
‘LM LPHDL TCP-Keepalive 10
B Misc
Capkion SPAZC40x_MODEUS
Description MODEBELUS SPa G
B user Level
UserLevel Enginesr
Caption
#
A051858
Fig. 5.6.1.-1 Uplink network settings
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e Default Gateway

The IP address Default Gateway defines the gateway address that forwards the IP
traffic between the local subnet and the outside world. The default IP address is
192.168.2.1 and this has to be changed according to the planned network
structure.

o [P Address

The IP address identifies SPA-ZC 400 in the local area network (LAN). All
communication via SPA-ZC 400 uses this address. The default value
192.168.2.10 has to be changed to a unique address according to the planned
network structure.

e SNTP Servers

SPA-ZC 400 uses SNTP as its own real-time clock. The time is used to
synchronize an IED with Modbus. The secondary SNTP server is used if the
primary SNTP server for some reason drops off the network.

e Subnet mask

The Subnet mask address defines which addresses have access to the default
gateway.

e TCP-Keepalive

The status of the TCP/IP connection is monitored by transmitting keep alive-
messages at configured intervals. This is done invisibly to the user. The value is
in minutes and the default is 10 minutes.
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5.6.2. Communication parameters for Modbus
EETLocal Server'\REF54x MODBUS_TCP Test - Communication Engineering Tool for SPA-2C40% - |EI|5|
File  Edit MWiew  Tools  ‘Window  Help
ZH[$RE EEED
Project Explarer Object Properties o=
Communication | 5 8 |
Elﬂ _EEFSJ'X MODBUS_TCP Test E [030] MODBUS Communication Paramaters
E'"E fEAfSSDX—MODBUS Baud Rate 19200 Bits / 5
o LN LLMO [rakabits 8
T MODEUS-Timesynch REF/REM/RET54_
=-L0 [T Nur_malCRCOrder False
_____ LM LLMO1 Parity Even
‘LM LPHOM PriarityClient 1
PriarityClientz
PriorityClient3
PrioritwClients
Receive Timeouk Foa
Retransmissions [
Stophits 1
Tirne Address ]
Time Zone Correction 120
B Misc
Zapkion LD1
Description IECA1850GW Logical Device
Caption
o
A051854
Fig. 5.6.2.-1  Modbus communication parameters
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Baud Rate

The possible communication speed settings of the Modbus bus are:

e 1200 bps

e 2400 bps

e 4800 bps

e 9600 bps

e 19200 bps

e 38400 bps
Receive Timeout

Receive Timeout defines how long SPA-ZC 400 waits for the slave’s respond
before it considers the slave to be non-responding. The unit is milliseconds.

Retransmissions
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5.7.

Retransmissions defines how many times a message is resent after connection is
considered to be temporarily broken.

e Modbus-Timesynch

If enabled, SPA-ZC 400 sends time synchronization messages to the relay. If
SPA-ZC 400 is not connected to a SNTP server, time synchronization to the
slave should be disabled as well.

e Time Zone Correction

Due to the SNTP time synchronization, a time offset must be added to the
Modbus time synchronization message depending on the time zone. The value is
in minutes and ranges from -720 to 720. It is comparable to the Coordinated
Universal Time (UTC).

e PriorityClientl...PriorityClient4

When using multiple Modbus clients, there can be up to four so called Priority
Clients. These clients are never disconnected by SPA-ZC 400. A client, who is
not a Priority Client, can be disconnected to ensure a new client connection if the
maximum number of connections is exceeded.

e NormalCRCOrder

If enabled, the low—order byte of the Modbus Checksum field is appended first,
followed by the high—order byte. In this case, the CRC high—order byte is the last
byte to be sent in the message.

Downloading configuration

After you have built the object tree and done the communication configuration, you
can download the configuration to SPA-ZC 400:

1. Select the SPAZC40x_MODBUS Device object and right-click to select the CID
Export.

2. If you download configuration to SPA-ZC 400 the first time, change the IP
address from default address (192.168.2.10) to new IP address according to the
planned network structure.

When downloading the device's configuration, the device’s current IP address must
be used as Target IP Address, see Fig. 5.7.-1. When using previously non-
configured SPA-ZC 400, default value (192.168.2.10) should be used.

When the new configuration to SPA-ZC 400 is downloaded, Communication
Engineering Tool (CET) checks if the basic IP addresses are changed. If a change is
detected, CET asks whether new addresses are taken into use. If the changes are not
accepted, SPA-ZC 400 uses the old IP address from the previous configuration. The
IP addresses can be verified with, for example, I[P Query Tool. For more information
about IP Query Tool, refer to Section 8.3. IP Query.
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File  Edit Wiew  Tools  Window  Help

EETLocal Server',REF54x MODBUS_TCP Test - Communication Engineering Tool for SPA-2( - |EI|5|

FH s BE EFEH
| Project Explorer ? % || gpazC40% MODBUS - CID Export ‘ 11

Communication SPA-ZC 40
=8 REFS4x MODBLS_TCP Test || | Target IP Address ' tirite File to SPA-ZC 40x Wirite
[ ‘Write File to Hard Disk
|192.168.2.1IJ o ,
[~ ‘Write File to Hard Disk as ICD
[T Export Datasets DO Level
é'"L_D L1
LN LLMOL
f LM LPHD
ol [2]] 4 | »
s
A051856
Fig. 5.7.-1 Downloading the device's configuration
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If SPA-ZC 400 is connected to a system where the connection to it can be obtained,
the Export function tries to determine the SPA-ZC 400 version and exports the
export file accordingly. If the connection is disabled, prompt the correct version to

be exported, see Fig. 5.7.-2.

CID Export |

] Unable to determine version of SPA-ZC 40x. Do you wank to Export version 2.07(Yes = Export 2.0, Mo = Export
e} 11ap

A060129

Fig. 5.7.-2 Selecting correct SPA-ZC 400 version to be exported
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6.1.

Commissioning

The downloaded Configuration file is taken into use when SPA-ZC 400 is restarted
automatically.

Normally, the device is reset automatically after the configuration is downloaded
with Communication Engineering Tool (CET) for SPA-ZC 40x.

After downloading the configuration you can check the basic TCP/IP functionality
with the ping command in command prompt:

c:\>ping x.X.x.X.

You can see how the configuration process is progressing from the diagnostic LEDs.
When the SPA-ZC 400 configuration is completed, the green LED is on.

If the configuration fails, check the error log files from the SPA-ZC 400 file system.
The status and error logs are located in the /log directory. For more information
about maintenance, refer to Chapter 8. Maintenance and service.

Checking Modbus TCP communication

To check the Modbus TCP communication, open the MODBUS/TCP client, for
example Communication Engineering Tool (CET) for the IEC 61850 OPC Server,
then send a Read Holding Registers message querying some Modbus points
supported by the Modbus slave connected to the serial port of SPA-ZC 400. In the
reply you receive the slave’s data for those registers.

If you have Modbus Time Synchronization enabled in the SPA-ZC 400
configuration, you see the Modbus communication indicator LEDs blinking
periodically even if the MODBUS/TCP client is not connected.
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71.

Technical data

Interfaces

IED interface

¢ Fixed mechanics and fixed connectors for REF 541/3/5, REM 543/5 and
RET 541/3/5 protection relays

e D-type subminiature connector for simultaneous dual port communication
(optional, see Table 3.1.).

Ethernet interface

e Multimode MT-RJ
e Multimode LC
e RJ-45 for STP CAT5e

LON/SPA interface (Optional)

e Fibre-optic connector options
e ST multimode glass fibre transmitter/receiver pair or

¢ Snap-in multimode plastic fibre transmitter/receiver pair

Optical fibres

e See fibre-optic guides:
e SPA-ZF Optical glass fibres, multimode graded index type
e Plastic-core fibre-optic cables, features and instructions for mounting

For more information, see Section 1.4. Product documentation.

Diagnostic LEDs

SPA-ZC 400 common diagnostic LEDs

e Power

e Diagnostic
e Red
e Green

e Yellow

LAN diagnostic LEDs
e LINK

o TX

e RX
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SPA-ZC 400

1MRS756014

LON/SPA diagnostic LED
e RX

Dimensions and weight

26
—>
43 20.4
e
A
. O s
MIpp
SPA-ZC 400 [l

ETHERNET ADAPTER

[pLasTic [JGLASS

[JiEc 61850
[ImMopBuUS / TCP

[JspasTcP

LO 00-0C-02-B0-CC-00
y I
[=
SEI;l\{\:CE u
© @
 J
A040130B

Fig. 7.1.-1 Dimensions of the SPA-ZC 400 module
Table 7.1.-1 Dimensions and weight
Type Dimensions [mm] Weight [g]
SPA-ZC 400 195 x 50 x 26 130
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Test and conditions

Table 7.2.-1

Environmental test and conditions

(continuous)

Recommended service temperature range

-10...+55°C

Transport and storage temperature range

-40...+85°C according to the IEC 60068-2-48

Dry heat test

According to the IEC 60068-2-2

Dry cold test

According to the IEC IEC 60068-2-1

Damp heat test, cyclic

According to the IEC 60068-2-30

Table 7.2.-2

Electromagnetic compatibility tests

EMC immunity test level meets the requirements listed below.

1 MHz burst disturbance test, class Il
e Common mode
¢ Differential mode

According to the IEC 60255-22-1
2.5kV
1.0 kV

Electrostatic discharge test, class lll

e For contact discharge
e For air discharge

According to the IEC 61000-4-2 and IEC 60255-22-
2

6 kV
8 kV

Radio frequency interference tests
e Conducted, common mode

¢ Radiated, amplitude-modulated

¢ Radiated, pulse-modulated

According to the IEC 61000-4-6 and IEC 60255-22-
6 10 V (rms), f=150 kHz...80 MHz

According to the IEC 61000-4-3 and IEC 60255-22-
310 V/m (rms), f=80...2700 MHz

According to the ENV 50204 and IEC 60255-22-3
10 V/m, =900 MHz

Fast transient disturbance tests

e All terminals

According to the IEC 60255-22-4 and IEC 61000-4-
4

4 kV

Surge immunity test
e Power supply

According to the IEC 61000-4-5
4 KV line-to-earth, 2 kV line-to-line

Power frequency (50 Hz) magnetic field
IEC 61000-4-8

300 A/m continuous

Electromagnetic emission tests

¢ Conducted, RF-emission (Mains
terminal)

Radiated RF-emission

According to the EN 55011
EN 55011, class A, IEC 60255-25

EN 55011, class A, IEC 60255-25

CE approval

Complies with the EMC directive 2004/108/EC and
the LV directive 2006/95/EC
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Table 7.2.-3 Standard tests

Mechanical tests

Vibration tests (sinusoidal)

Shock and bump test

According to the IEC 60255-21-1, class |
According to the IEC 60255-21-2, class |

Table 7.2.-4 Standard tests

Supply current consumption

Running

Start up

340 mA
430 mA
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8. Maintenance and service

If the SPA-ZC 400 module or a part of it is found to be faulty, the normal service
operation is to replace the entire module.

8.1. LED indicators

Table 8.1.-1 LED indicators

LED Color State Sequence Description
number
Power Green On Power on
Link LAN  |Green On Indication for LAN link OK
RX LAN Green On Indication for incoming LAN traffic
TX LAN Green On Indication for outgoing LAN traffic
DIAG Green Red Off On 1 Bootloader booting
Flashing On 2 Bootloader, missing boot image
On On 3 Starting
Flashing Off 4 OK, missing configuration
On Off 5 OK, configuration in use
Off Flashing 6 Configuration error
RX Green On Indication for incoming LON traffic (LON
and SPA)
Possible sequences are:
1-3->5 Normal situation
152 Missing boot image
1-3-4 Configuration file is missing
1-3->6 Configuration error

8.2. Communication settings

REF 541/3/5, REM 543/5 and RET 541/3/5 addresses or baud rates are not properly
defined if:

e Diagnostic counter SPAReplyTimo increases constantly and SPAReplyData
remains 0 in the LD0.CDGGIOI1 logical node. These diagnostic counters are
readable from the IEC 61850 client.

¢ Quality of the data is INVALID.

The following IED-specific settings have to be checked when setting up
REF 541/3/5, REM 543/5 or RET 541/3/5:

e Protocol selection for SPA-ZC 400

Table 8.2.-1 explains the possible port configurations of REF 541/3/5, REM 543/5
or RET 541/3/5.

information, see Technical Reference Manuals of REF 541/3/5,

E The protocol selection is active only after rebooting the relay. For more
REM 543/5 and RET 541/3/5 .

37



SPA-ZC 400 Ethernet Adapter 1MRS756014
Modbus/TCP Brigde

Installation and Commissioning Manual

Table 8.2.-1 Protocol selection for REF 541/3/5, REM 543/5 and RET 541/3/

5
Connectors/Communication parameters
X3.2/Protocol 2 X3.3/Protocol 3 Front connector
SPA (SMS) LON SPA
SPA (SMS) SPA -
IEC 60870-5-1032 LON SPA
IEC 60870-5-103) SPA (SMS) -
IEC 60870-5-103% - SPA
DNP 3.09 LON SPA
DNP 3.09 SPA (SMS) -
DNP 3.0 - SPA
Modbus LON SPA
Modbus SPA (SMS) -
Modbus - SPA
- SPA SPA
IEC 61850 LON SPA
IEC 61850 SPA -

@ Not included in REM 543/5
®) Not included in REM 543/5
) Not included in REM 543/5
9 Not included in REM 543/5
) Not included in REM 543/5
) Not included in REM 543/5

device. By default SPA-ZC 400 is configured to poll SPA events. In

E Only one SPA client can be configured to poll SPA events from the
this case, it is not allowed to poll SPA events from another SPA client.

e SPA command timeout in IED

SPA command timeout should be < 1 second when LON interlocking is not in use.

e SPA baud rate and SPA slave number in IED

Baud rate and slave number have to be according to the SPA-ZC 400 configuration
in X3.2/Communication 2.

8.3. IP Query

By using the IP Query Tool in Communication Engineering Tool (CET) for SPA-ZC
40x, it is possible to see all connected SPA-ZC 40x, devices, their communication
parameters and version information.

Example:

Sending IP query 1
RECEIVED MESSAGE FROM 10.58.125.151:
Mac Address: 00-0C-02-B0-04-89
Subnet Mask: 255.255.255.0
Default Gateway: 10.58.125.150
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SPA-ZC 400

SNTP servers:10.58.125.150 127.0.0.1
SW_SPATYPE: SPA-7ZC40x

SW_NUMBER: 1MRS118533

SW_BUILD: 110

SW_REVISION: B

Compiler DATE TIME: Nov 28 2005 12:38:02
To use the IP Query Tool:
1. Select Tools > IP Query Tool to start the tool, see Fig. 8.3.-1.

Query activates devices from the network until it is stopped.

EET Local Server\REF543R IEC61850 Test - C
File  Edit  View | Tools | Window  Hel

= nl clflo h_ Signal Mapping "
|h_ IP Query Toaol

Project Explorer |
Carmmunication | Qptions...

A060127

Fig. 8.3.-1 Starting the IP Query Tool

2. Select the Network adapter to send a query, see Fig. 8.3.-2.
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EET Local Server\Protocol Test - Communication Engineering Tool for SPA-ZC40x I ] |
File  Edit iew  Tools  Window  Help

FH iR EFaD0
[ Project Explarer x| Query Tuul| 1 b o=
Carmmunication I

=8 Protocol Test Guery IPs Network Adapter: [194.241.64.243 7|

-5 SPAZC40x

v Send query as broadcast

Stop Search

Fig.

8.4.

40

A060128

8.3.-2 Selecting Network adapter

3. Click Start to start the query.
4. Click Stop to stop the query.

Connected devices are displayed in the Output pane, Fig. 8.3.-2.

Additional information depends on the SPA-ZC 40x version. If version 1.1.1 is
used, only MAC address is displayed. If version 2.0 is used, MAC address, other
address and revision information is displayed.

Identification
If contacting the Customer Service, it is necessary to send the following information
by request:

e Version information of Communication Engineering Tool (CET) for SPA-ZC
40x

Select Help > About to view the version information.

e SPA-ZC 400 version information
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8.5.

The version information can be read from the device's label. If the device is
updated afterwards, use CET's IP query to get the correct version information
from the device memory. For more information about IP query, refer to
Section 8.3. IP Query.

Obtaining error logs

The following session transfers error.log file through fip.

C:\>ftp x.x.x.Xx

User: abb

Password: abb
ftp> cd log

ftp> get error.log
ftp> quit
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9. Ordering information

SPA-ZC400MMG

L Optical transmitter and receiver for SPA/LON bus
P = plastic fibre cable
G = glass fibre cable
- = no fibre option

Ethernet connector type

M= MTRJ
L =1LC
R= RJ-45

Protocol type

M = Modbus/TCP
E = IEC 61850

S = SPA/TCP

t——— Deuvice type

A060158

Fig. 9.-1 Ordering information for SPA-ZC 400

SPA-ZC400CD

e SPA-ZC 400 configuration CD
e Engineering tool, Communication Engineering Tool (CET) for SPA-ZC 40x

get the Communication Engineering Tool. The SPA-ZC 400 package

E Order at least one SPA-ZC 400 configuration CD with your delivery to
does not include the configuration CD by default.
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10. Terminology

Term Description

Communication Engineering | Also known as CET. Software for configuring and monitor-
Tool ing communication gateways or communication front ends.

Intelligent Electronic Device Also known as IED. Devices containing advanced logics
such as meters, protection and control relays and trip units.

Modbus By extension, communication board implementing the
Modbus protocol for REF 542plus.

Snap-in Connector type for plastic fibre cable

SPA Data communication protocol developed by ABB

ST Connector type for glass fibre cable
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SPA-ZC 400

11. Abbreviations

Abbreviation

Description

CD

Change detect; compact disk

CET

Communication Engineering Tool

CID

Configured IED description

CRC

Cyclical redundancy check

EMC

Electromagnetic compatibility

FTP

File transfer protocol

IED

Intelligent electronic device

IP

Internet protocol

LAN

Local area network

LED

Light-emitting diode

LON

Local operating network

PC

Personal computer

SNTP

Simple Network Time Protocol

SPA

Data communication protocol developed by ABB

SQL

Structured query language

STP

Shielded twisted pair

TCP

Transmission Control Protocol

uTtcC

Universal time clock
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